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Introduction 

Intended Use 
The BioRadio is not FDA cleared to market. It is not intended for use in experimentation that involves human testing 
without specific IRB approval. This product is not intended to monitor vital signs or be used for diagnosis.  

Contraindications 
The radio component in the BioRadio complies with FCC requirements (FCC-ID XDULE40-D2). 

Warnings 
 Improper routing of leads may result in a choking hazard. 
 Do not use in conjunction with a defibrillator. 
 Do not connect the device to the user when a USB cable is connected for charging or data transfer. 

For proper battery disposal, follow procedures as defined by local regulations or return to Great Lakes 
NeuroTechnologies Inc. 

 

NOTE: The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications to this 
equipment. The following will immediately void equipment warranty: device tampering, attempted removal of the 
tamper seal, misuse of the device, misapplication, and device modification.  In addition, unauthorized modifications to 
the equipment will void the end-user’s authority to operate the equipment. 

Minimum System Requirements 
• Windows 7 
• Intel 1.86 GHz CPU (or equivalent) 
• 1GB RAM (2GB for 64-bit systems)  
• 1024 X 768 or greater display resolution 
• One available USB 2.0 port 
• 1GB hard disk space 

• Microsoft compatible keyboard and mouse 
or other pointing device 

• Adobe Acrobat Reader 
• Microsoft .NET Framework 4.5 
• Bluetooth® 4.0 radio or adapter 

NOTE: Product performance may vary based on your system configuration. 

Package Contents and Warranty Information 
Great Lakes NeuroTechnologies Inc. thanks you for your recent product purchase. GLNT offers phone technical 
support (9 AM-5 PM EST) and warrants the BioRadio (parts and labor) for one year from the date of purchase. 
Technical support after the warranty period will be charged hourly. Call GLNT for hourly rates. For your benefit, we 
recommend that you record the pertinent details below. If necessary, this information will allow us to better serve 
your needs. We highly recommend that you staple a copy of the sales receipt to the blank pages in the back of this 
manual. 

Please check to make sure your kit has the required components and record the requested data: 

S/N:   ☐ BioRadio 
   ☐ Bluetooth® adapter 

Device ID:   ☐ USB data cable 
Date of 

Purchase: 
  ☐ Carry case 

  

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO THE FOLLOWING TWO 
CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT 
ANY INTERFERENCE RECEIVED, INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION. 
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Chapter 1: BioRadio Hardware 
 
 

Overview 
The BioRadio is a wireless data acquisition system capable of recording, displaying, and analyzing physiological signals 
in real time. Using sophisticated wireless and miniaturization technologies, the BioRadio provides physiological data 
acquisition that is untethered thus allowing one to move freely while monitoring physiological signals from a 
computer. 

The BioRadio is worn by the person and is designed for acquiring physiological signals from sensors attached on the 
body. Physiological signals are amplified, sampled, and digitized, which can be wirelessly transmitted to a computer 
Bluetooth receiver and/or recorded to onboard memory for post-analysis. 

 
Figure 1: BioRadio Primary Module and Sensor Pod 

BioRadio 

The BioRadio can be configured with a variety of sensors to acquire physiological signals. Wireless streaming and 
recording is done over a Bluetooth 2.4-2.484 GHz band and approximately 100 foot range. Data can simultaneously 
be recorded to onboard memory for post analysis. Battery charging is done over a micro-USB port and provides at 
least eight hours of typical use. The two-character device ID is located on the back of the unit. 

The BioRadio consists of two main hardware components, the Primary Module and the Sensor Pod. 

Primary Module 
The Primary Module (Figure 1) can be powered on by pressing the top button on the left side of the primary module 
and can be turned off by holding the button for five seconds. Three modes will be available to the user (Table 1). 

First, Configuration Mode  indicates to the user that the BioRadio is not recording data and will allow the user to 
customize the device’s configuration if connected to a computer over the Bluetooth connection. When the primary 
module is searching for a connection, the wireless connection indicator  Bluetooth symbol will pulse and signal 
strength bars will cycle through the three levels. Once connected, the wireless connection indicator will be solid and 
indicate the signal strength via the three (3) horizontal bars next to the Bluetooth symbol. 
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Table 1: BioRadio Modes and LED Indicators 
BioRadio Indicator Description 

 
Configuration Mode 

 

Data Acquisition Mode 
(Streaming and/or 
Record to Memory) 

 
Recording to Memory 

 
Wireless Connection 

 

Battery Level and 
Charging 

The user can now program the BioRadio channels for either differential (up to four channels) or singled-ended (up to 
eight channels and a reference) mode. The ground input will always be enabled. Input resolution and sampling rate 
can also be set. These inputs are primarily designed to record from biopotential sensors, such as off-the-shelf snap-
type or gold cup electrodes that attach to the body on one end and plug directly into the primary module on the other 
end. 

Physiological signals that can be recorded include, but are not limited to, Electroencephalogram (EEG), 
Electromyogram (EMG), Electrooculography (EOG), and Electrocardiogram (ECG). A differential channel may also be 
configured for galvanic skin response (GSR) using only two surface electrodes or respiratory inductance 
plethysmography (RIP) using an inductive chest band. An embedded motion sensor in the BioRadio records triaxial 
linear acceleration and angular velocity. Positive and negative axes are indicated in Figure 2. 

 
Figure 2: Accelerometer Axes 

Data Acquisition Mode  indicates to the user that data is being actively streamed to a computer over a Bluetooth 
connection and/or recorded to the primary module’s onboard memory. Wireless streaming is initiated from 
BioCapture software. While streaming, the data acquisition mode indicator will pulse and the wireless connection 
indicator will be solid. 
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Recording to memory  can be initiated by pressing the middle button on the left side of the primary module. When 
enabled, the corresponding indicator  will become solid. Based on the 8 GB onboard memory, the primary unit will 
be capable of recording 8 channels of EEG at 500 Hz sampling rate and 1 µV resolution for over 90 hours. The memory 
indicator will turn red when less than thirty minutes of recording remains. A new *.dat file will be created every time 
a record to memory session is started. File names will be formatted as <alpha><beta><HH><MM><SS>.DAT, where 
the following values are based upon the date and time at which the recording is started: 

• <alpha> ranges from 1 to 9 and A to C, each representing a month (1 to 12) 
• <beta> ranges from 1 to 9 and A to V, each representing a day of the month (1-31) 
• HH ranges from 0-23 
• MM ranges from 0-59 
• SS ranges from 0-59 

NOTE: The BioRadio cannot be reconfigured when data acquisition is in progress. 

NOTE: If the date is unable to be initialized, the filename will default to the name #.DAT where # is a number 
starting at 00000001 and incrementing by one for each file name with an error. 

While in data acquisition mode, the user can indicate an event by pressing the bottom button on the primary module. 
These events can be recorded to onboard memory or streamed to a computer. 

Update Mode indicates to the user that a BioRadio firmware update is in progress. When a firmware update is 
available for the BioRadio, download the file from http://glneurotech.com/bioradio/ to the computer and follow these 
steps: 

1. Turn the BioRadio on and ensure it is in Configuration Mode. 
2. Connect the BioRadio to the computer using the USB cable and wait for the removable drive to appear.  
3. Open the removable drive on the computer and copy the firmware update file into the ‘glnt’ folder. If one does 

not exist, create a new folder with the same name. 
4. Power down the BioRadio and disconnect the USB cable. 
5. Reconnect the USB cable. The recording to memory icon will turn blue for 10 seconds and then turn off. 
6. The new firmware is now loaded. Power the BioRadio on. 

The battery level indicator  will update at 100%, 66%, 33%, and less than 6% of battery capacity. If the charge level 
is less than 6%, the battery symbol will turn red. When charging, the battery symbol will pulse.  

Sensor Pod 

Each sensor pod (Figure 1) allows the user to connect one pulse oximeter and one sensor (Table 2). The BioRadio 
supports the following sensors: hand dynamometer, spirometer, surface temperature sensor, force plate, and blood 
pressure sensor. Each pulse oximeter records outputs photoplethysmogram (PPG), heart rate, and oxygen saturation. 
The BioRadio can record from up to two sensor pods at a 250 Hz sample rate. 

NOTE: It is recommended to connect the sensors to the sensor pod before starting acquisition. 

Table 2: Supported Sensor Pod Inputs 
Sensor Measurement 
Hand Dynamometer Force (Newtons) 
Spirometer Air Flow Rate (Liters per second) 
Surface Temperature Sensor Temperature (Fahrenheit) 
Force Plate Force (Newtons) 
Blood Pressure Cuff Pressure (mmHg) 

Pulse Oximeter 
Photoplethysmogram (units) 
Heart Rate (Beats per minute) 
Oxygen Saturation (Percent) 

http://glneurotech.com/bioradio/
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Chapter 2: System Setup 
 
 

Installing BioCapture Software 
1. Go to https://glneurotech.com/bioradio/support-page/bioradio-software-downloads/ 

(Updates to BioCapture software will also be provided from this link). 
2. Enter the password to access the software link (provided by sales representative and also included in Quick 

Start Guide)  
3. Download the BioCapture Software  
4. Install the software and follow the on-screen prompts. 

Bluetooth Setup 
The BioRadio acquires and streams data over a Bluetooth connection with the computer. The following steps will 
guide you through the Bluetooth setup: 

Enable the Bluetooth radio on the computer.  

• If the computer is not equipped with internal Bluetooth, connect the external Bluetooth adapter provided 
with the BioRadio system into a USB port on the computer and wait for the automated driver install to 
complete. 

• If the computer is equipped with internal Bluetooth, the internal Bluetooth receiver must be disabled before 
the external Bluetooth receiver can be used.  

BioRadio Device ID 
Each BioRadio is assigned a unique device ID located on the back of each unit. The first time a BioRadio is used with 
a computer, the BioRadio must be paired with BioCapture software.  The unique device ID will ensure that you are 
selecting the correct BioRadio to pair with BioCapture (Figure 3). 

 

 
Figure 3: BioRadio Device ID 
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Pairing the BioRadio to BioCapture Software 
 
1. Ensure that the BioRadio is turned on 
2. Click Device and then Select Device  
3. A list of BioRadio devices turned on and not connected to other computers will appear (Figure 4) 
4. Select the device ID and click Connect 
5. The first time BioCapture connects to a specific BioRadio, wait for the driver and Bluetooth activities to complete.  
6. The BioRadio ID will now display on the BioCapture status bar at the bottom of the window. 
7. Follow the same steps to reassign the BioRadio ID. 
8. One is only able to connect to a BioRadio unit when the device is in configuration mode and not recording to 

memory. 
 
 

 
Figure 4: Select BioRadio Device Window 

 
 

NOTE: Once your BioRadio has been paired with the BioCapture software, you are able to connect and 
disconnect the connection between the two by pressing the “connect” or “disconnect” in the toolbar 
(refer to Figure 5). 

 
Figure 5: Connecting/ Disconnecting BioRadio to BioCapture 
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Chapter 3: BioCapture Software 
 
 

The BioCapture software allows the user to collect, display, save and analyze physiological data collected from the 
BioRadio. The intuitive design provides access to hardware configuration, data collection, review and analysis. 

Status Bar 
The status bar at the bottom of the BioCapture main window will display the connection state of the BioRadio, the 
device ID, and the device firmware version and the dropped packet count when connected. 

Configure the BioRadio 
Configuration of the BioRadio is performed through the Configuration Window, accessible from the tool bar or device 
menu (Figure 6). When the BioRadio is connected to BioCapture, the Device Config option becomes available. When 
selected, a window will open allowing one to configure the BioRadio channels.  

Configuration Name  

When the BioRadio is configured, the configuration parameters are saved to the BioRadio under a custom name. This 
name can also be used to identify a saved BioCapture session (see Saving/Open Sessions under the Data Review 
section). 

Programmable Channels 

The BioRadio primary unit can be programmed for either four differential or eight single-ended channels. Each 
channel can be individually enabled and assigned a name, which will appear as the y-axis label when streaming data. 
The default channel name will be the channel number. 

 

Figure 6: Configuration Window 

Sample Rate 

The BioRadio programmable channels can be set to 250 Hz, 500 Hz, 1 KHz, 2 KHz, 4 KHz, 8 KHz, or 16 KHz. All channels 
are sampled at the selected sampling rate.  The Sensor Pod and internal Motion Sensors are sampled at 250 Hz. 
  



Page 11 of 17 
 © 2017 Great Lakes NeuroTechnologies 

+1 216-361-5410 · 855-456-3876 · info@glneurotech.com 
 

Channel Type 

Each programmable channel can be predefined for various applications. One can select from electroencephalogram 
(EEG), electromyogram (EMG), electrooculography (EOG), and electrocardiogram (ECG) as well as galvanic skin 
response (GSR) using only two surface electrodes or respiratory inductance plethysmography (RIP) using an inductive 
chest band. The channel type selected from the dropdown menu will assign the input resolution (see resolution Table 
3 for corresponding bit resolutions) and input range. The custom type will allow one to specify the voltage resolution 
between 1µV and 5mV. 

NOTE: Signal amplitudes outside of the input range will rail and be assigned the positive or negative limit 
value. 

NOTE: For GSR applications, the BioRadio must be configured for differential mode with GSR on Channel 1 

 

Table 3: Programmable Channel Type Specs 
Type Resolution 

(voltage) 
Resolution 

(bits) 
Input Range 

EMG 6 µV 24 ±0.094 V 
ECG 6 µV 24 ±0.094 V 
EEG 1 µV 24 ±0.094 V 
EOG 6 µV 24 ±0.094 V 
RIP 1 µV 24 ±0.094 V 
GSR * 

*Settings will not be displayed on the BioCapture configuration screen for GSR 

Sensor Pod Channels  

The BioRadio can support up to two sensor pods. Each can be configured for a sensor and/or pulse oximeter. Each 
sensor channel can be assigned to a specific sensor type. BioCapture supports the blood pressure sensor, spirometer, 
hand dynamometer, force plate, and surface temperature sensor. The pulse oximeter will generate three signals: 
heart rate, oxygen saturation, and photoplethysmogram (PPG). All sensor pod inputs will be recorded at 250 Hz 
sample rate and 12-bit resolution.  

Motion Sensors 

Enabling motion sensors displays six graphs for tracking linear acceleration (g) along the X, Y, and Z axis and angular 
velocity (degrees/second) about each respective axis.  The motion sensors have a sample rate of 250 Hz. 

Bandwidth Indicator 

The bandwidth indicator will update to indicate whether wireless streaming and recording to memory will support 
the current configuration. Table 4 outlines the four possible bandwidth ranges. 

 
Table 4 Bandwidth Streaming Support 

Bandwidth (Kbps) Wireless Streaming Record to Memory 
0-152 Supported Supported 

153-190 Not recommended Supported 
191-500 Not supported Supported 

501+ Not supported Not supported 

Program Device 

To finish, click the “Program Device” button at the bottom of the window. The main window will now appear with the 
channels displayed for the selected configuration. 
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Data Collection 

Start Acquisition 

Once the device configuration is complete, click the green arrow ( ) in the tool bar to start data acquisition. Clicking 
the blue square ( ) will stop data acquisition. 

NOTE: Missed packets in the wireless data stream appear as gaps in the graphs. 

Record Data 

To record data, click the record icon ( ) in the tool bar. A window will appear prompting you to enter a file name and 
choose the file location. BioCapture recording files have the extension *.bcrx. Once a file name and location have 
been selected, click Save and data will begin to scroll on the screen. To stop recording, click the record icon and the 
outline will disappear. To stop data collection, click the stop icon ( ). 

Event Markers 

During data acquisition, event markers can be generated. Software event markers can be customized by selecting 
Edit and event markers in the main menu bar when data acquisition is stopped. Create an event marker by pressing 
a key to assign that as the trigger during data collection, selecting a name and color, and click “Add.” Press another 
key to customize additional event markers. Click OK to accept and save the event markers. During data acquisition, 
press the appropriate key to mark the corresponding event. Events will appear as vertical lines across all displayed 
graphs and will be recorded to BioCapture recording files (*.bcrx) or exported *.csv files. 

Hardware event markers can be generated by pressing the bottom button on the BioRadio primary module. When 
streaming to the computer, hardware event markers will appear on the graphs. When recording to memory, event 
markers will appear in the BioCapture recording file when imported.   

Data Review 

Save/Open Recordings (*bcrx files) 

To review data, open a recording file by selecting Open and then Recording from the File menu or the File Open icon 
in the tool bar. Navigate to your saved recording file and click open. BioCapture will read the recording file and display 
the recording in the main window. Use the cursor at the bottom of the screen to scroll through the data. In order to 
easily review hardware and software event markers that were added during data collection, select View and Event 
Navigator. This window lists all recorded events during data acquisition. If you double click on a specific event, the 
BioCapture review window automatically moves to the selected event marker time stamp. 

Import Memory Records 

BioRadio data recorded to the onboard memory can be imported to BioCapture by selecting Data and then Import 
Memory File from the top menu bar (Figure 7). Select the Source file (*.dat) and destination (*.bcrx) filename. 
Optionally, one can load the recording file once the conversion is complete. The BioRadio drive may take up to 15 
seconds to appear on the computer. 

 
Figure 7: Import Memory File Prompt 
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NOTE: Once connected via the data USB cable, *.dat files are only accessible when the BioRadio is 
disconnected from BioCapture (refer to Chapter 2, number 8 note, for instructions on how to 
connect or disconnect). 

NOTE: When already recording to memory, connect and stream wireless performance may vary based on 
BioRadio configuration. 

NOTE: A Destination File must be entered in order to import the memory record. 

Save/Open Sessions (*bcsx files) 

Configuration parameters and data display settings (e.g. filters, software gain and offset, units, graph settings) can be 
saved to a session file for later use. From the File menu, select Save Session. Enter a filename and click Save. To open 
the session, select Session from the Open menu. Select the file from the list in the Open window and click Open. Your 
customized display options will be visible. 

Configure Display Properties 
Display properties can be customized when streaming or recording data from the BioRadio to BioCapture or when 
reviewing a loaded BioCapture recording file. 

Set Graph Time Span 

The graph time axis can be adjusted using the Graph Timespan option in the tool bar. Available ranges are one to 
sixty seconds. When the Graph Timespan is set to 1 or 5 seconds, the x-axis will be displayed in increments of 
milliseconds. Any other timespan selection will display the x-axis in increments of seconds. Additionally, you can also 
collect data with the x-axis set to either elapsed time or real time display using the Time Scale option in the View 
menu. 

Graph Settings 

Graphs can be individually configured. Select which graphs are visible by clicking Hide Signals. Additional settings 
including toggling grid lines and signal and background colors can be customized by right clicking on a graph.  

Y-Axis Range 

By default, each graph is displayed with a fixed y-axis range based on the configuration selected in the Device 
Configuration window. The y-axis can either be scaled manually to a specific minimum and maximum or auto scaled. 
Right-click on the plot area and select Y-Axis to bring up the graph setting menu.  

The Y-axis submenu provides three scaling methods: 

1. Set Min/Max: Manually set the minimum and maximum values. 
2. Auto-scale Continuous: BioCapture will automatically scale the y-axis to fit the data currently being displayed 

and continue to update as more data is acquired. 
3. Auto-scale Quick: BioCapture will scale the y-axis once to fit the data currently displayed on the graph. Press 

Ctrl-A to auto scale all graphs. 

Cursor 

The graph cursor can be enabled by right clicking on a graph and selecting cursor from the menu. A crosshair will 
appear on the graphed signal and display the x and y coordinates at that point. The cursor can be dragged along the 
signal to view specific points. This feature is most useful when reviewing data and not streaming. 

Signal Properties 

The signal properties can be accessed by either right clicking on a graph or from Edit on the top tool bar. The gain, 
offset, and units can be specified for each channel. Predefined values may vary based on the BioRadio configuration. 
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Filter Settings 

Various filters can be applied to an acquired signal. Filter settings may automatically be applied depending on the 
channel type (programmable or sensor pod) specified in the configuration. To add, modify, or remove a filter, right 
click on a graph and select Custom Filters.  

The custom filter dialog offers four types of filters:  

1. Lowpass: allows low frequencies to pass through  
2. Highpass: allows high frequencies to pass through  
3. BandPass: allows signals in frequency band range to pass through 
4. Bandstop: prevents signals in frequency band range to pass through 

Once the type of filter is selected, one of five filter designs can be chosen:  

1. Elliptic: equiripple behavior in both the passband and the stopband  
2. Bessel: linear filter with a maximally flat group delay, or maximally linear phase response 
3. Butterworth: has a frequency response as flat as possible in the passband 
4. Chebyshev: a steeper roll-off and more passband or stopband ripple 
5. Inverse Chebyshev: flatter in the passband than the Butterworth 

Depending on the filter type and design, other filter parameters can be set: order, upper and lower cutoff, ripple, and 
attenuation. 

In addition, a notch filter can be applied to prevent 50Hz or 60Hz from passing. This filter is accessible by either right 
clicking in the graph display or in the menu bar by clicking on the Notch Filter icon ( ) to apply the filter across all 
channels).  

Frequency Analysis 
When streaming data or reviewing a recording, a power spectrum graph can be displayed by double-clicking on an 
individual graph or selecting the menu bar icon   ( ) to view the power spectrum for all graphs (8). The power 
spectrum will be calculated based on the most recent two seconds. 

 
Figure 8 Signal graph and power spectrum 

Exporting Data 
You can export recording data to a comma-separated value (.csv) file. With a saved recording file open, select Export 
to .CSV from the Data menu (Figure 9). 

From this dialog either the filtered or raw data can be exported. Exported file will contain a column corresponding to 
the elapsed time, one column for each signal, and a column for each event marker. Events are indicated by a ‘1’ and 
otherwise ‘0’. 
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Figure 9: Export to .CSV prompt 

Data Integrity Summary 

A summary of the integrity of a data file (i.e., the number of dropped or missed packets) can be accessed by 
selecting Integrity Summary from the Data menu (Figure 10). 
 

 
Figure 10: File Integrity Summary 

 

NOTE: Missed packets are represented as NaNs in the exported data file. 

Chapter 4: Software Development Kit 
 
 

A software development kit (SDK) is provided free of charge with the purchase of your BioCapture system. The SDK 
includes drivers for LabVIEW™ and MATLAB® providing the ability to create custom software applications using the 
BioRadio. The user can control BioRadio communications and acquisition and collect acquired data in real time. Also 
included in the SDK is example code demonstrating how to utilize the Virtual Instruments (VIs) and M-files in a 
program to acquire, plot and process the BioRadio Data. These drivers can be downloaded from the Great Lakes 
NeuroTechnologies website at:  http://glneurotech.com/bioradio/ 
  

http://glneurotech.com/bioradio/
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Chapter 5: Technical Specifications  
 
 

Table 5 Hardware Specifications 
BioRadio 
Transmission Range 100 feet line of sight 
RF Band 2.4-2.484 GHz ISM Band 
Input Range ± 2 V 
Bit Resolution 12 to 24-bit 

Noise 
0.30 µV rms (250Hz sample rate 
and gain of 24) 

Sampling Rate 250 Hz-16 KHz 
CMRR -100 dB 
Power Source Rechargeable battery  

Battery Life 
8 hours (streaming 4 
programmable channels) 

Battery Recharge Time 3-4 hours 
Input Impedance 500 MΩs 
Sensor Pod 
Sampling Rate 250 Hz 
Bit Resolution  12-bit 
Motion Sensor 
Sampling Rate 250 Hz 
Bit Resolution 16-bit 
Accelerometer Range ± 8 g 
Gyroscope Range ± 2000 deg/sec 
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Chapter 6: Frequently Asked Questions 
 
 

1. Why won’t my BioRadio connect to BioCapture? 

a. Verify that the following is true: 

i. The BioRadio LED display is on. 

ii. The device ID displayed on the BioCapture status bar matches your device 

iii. The computer’s Bluetooth receiver is enabled. If you are using the external USB Bluetooth 
adapter, disable the computer’s internal Bluetooth receiver. 

b. If you are still unable to connect, power cycle the BioRadio and close and open BioCapture. 

2. Why won’t my BioRadio turn off? 

a. If the normal shutdown procedure doesn’t work, press and hold the power and event marker 
buttons at the same time until the device shuts off. 

3. Why won’t my BioRadio appear as a removable drive on my computer? 

a. Verify that the unit is connected to the computer via a data USB cable and not a charge only cable. 

b. It is not recommended to be connected wirelessly to the computer when wanting to access the 
BioRadio drive. 

c. Verify that the BioRadio is disconnected from the BioCapture software 

d. Wait at least 15 seconds for the drive to appear after connecting the BioRadio to the computer via 
the USB data cable. 

4. Why does the data streaming into BioCapture have significant noise? 

a. Make sure the GND input is plugged in and is well positioned and secured on the body. 

5. Why doesn’t the sensor pod appear in the BioCapture configuration screen? 

a. BioCapture detects the number of sensor pods attached to the BioRadio when a wireless connection 
is initiated. Ensure that the sensor pod is attached, then disconnect from and reconnect to the 
BioRadio. The sensor pod should then appear in the configuration screen. 

6. As a troubleshooting step, how do I perform a hard reset when the device is locked up, unresponsive 
or otherwise not functioning as expected? 

a. Press and hold both the power and event marker buttons until the unit powers off.  This will take 
approximately 7 seconds.  

Appendix 
 
BioRadio™ and BioCapture™ are trademarks of Great Lakes NeuroTechnologies, Inc. 

Bluetooth® is a registered trademark of Bluetooth SIG, Inc. 

LabVIEW™ is a trademark of National Instruments Corporation 

MATLAB® is a registered trademark of The MathWorks, Inc. 
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